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Introduction
Welcome to the Microsoft Office Project Standard 2003 Product Guide. The purpose of this document is to assist you in your evaluation of Project Standard 2003 and give you a sense of the enhanced features and functionality that it offers.
Microsoft also offers an enterprise project management solution, called the Microsoft Office Enterprise Project Management (EPM) Solution. This guide, however, focuses on Microsoft Office Project Standard 2003. The EPM Solution is not specifically covered in detail herein; a separate enhancement guide has been prepared for the EPM Solution.
Microsoft Office Project 2003 Products and Offerings
Microsoft Office Project 2003 has offerings to help you meet your specific business requirements. Depending on your particular situation, Microsoft Office Project Standard 2003 or the Microsoft Office Enterprise Project Management Solution can help you with your project and resource management needs.
· Microsoft Office Project Standard 2003. Project Standard is the world's leading project management program. With Project Standard, you can manage schedules and resources, communicate project status, and report project information. Project Standard is for users who do not require Web-based coordination or collaboration with other project participants and who do not need to manage resources from a central repository across multiple projects.
· Microsoft Office Enterprise Project Management (EPM) Solution. The Microsoft Office EPM Solution brings together client, server, and Web-based technology to enable organizations to manage their project portfolio effectively, establish standards and best practices, centrally manage resources based on skills and availability, and enable effective communication and collaboration within project teams. The extensible, enterprise-scale architecture of the EPM Solution enables effective integration with other line-of-business (LOB) systems. The Microsoft Office EPM Solution consists of the following Microsoft Office Project 2003 products and technologies:
· Microsoft Office Project Professional 2003 is the enterprise project management program in the EPM Solution. Project Professional is used by project managers for effectively planning projects, optimizing resources, and implementing repeatable processes across an organization. Project Professional connects to Microsoft Office Project Server for enterprise project management functionality.

· Microsoft Office Project Server 2003 is the extensible platform that supports the EPM Solution. Project Server 2003 enables organizations to centralize and standardize project and resource information for greater visibility and consistent reporting across an entire work portfolio. Project Professional and Project Web Access are used to connect to and interact with data stored in Project Server. Project Server 2003 integrates with Microsoft® Windows® SharePoint™ Services (formerly called SharePoint Team Services from Microsoft) for collaboration functionality, including document management. Windows SharePoint Services is a component technology of Microsoft® Windows Server™ 2003 and therefore requires Microsoft® Windows Server™ 2003.
· Microsoft Office Project Web Access is the Web portal in the EPM Solution. Project Web Access provides project teams with real-time access to information stored in Project Server. Project Web Access is enabled through Project Server.
Microsoft Office Project Standard 2003 Overview
Microsoft Office Project Standard 2003 is the easy-to-use program in the Microsoft Office System for effective planning, tracking and communication of project information.  For Microsoft Office users who want to make an impact at work, Project Standard can help users plan, manage, and communicate project information, resulting in increased productivity and effectiveness.  Project Standard 2003 empowers users in three key areas:
Organized Work
Project Standard 2003 helps you better organize and manage work and people to ensure projects are delivered on time and within budget.

· Better organize your projects and people with the scheduling power and capabilities of Project Standard.

· Track and evaluate impacts of schedule and resources changes to overall project plans.

· Customize plans to capture information specific to your projects.

· Display the information you want to review.

Compelling Communications
Project Standard 2003 helps you effectively and succinctly convey project plans and status.

· Increase your impact at work by communicating and presenting ideas and information more effectively in programs in the Microsoft Office System and through industry-standard formats.
· Communicate more clearly by using new enhancements to effectively print one-page project schedules.

· Share project information with team members through Windows SharePoint Services.
Familiarity and Ease of Learning
Project Standard 2003 enhances your productivity and effectiveness by helping you easily learn and apply project management practices with a familiar and easy-to-use interface.

· Use familiar tools and built-in assistance to do more sophisticated and impactful work without the need for much additional training.

· Save time by transferring existing project plans between Project and other programs in the Microsoft Office System.

· Navigate and learn the program quickly with an updated interface that is consistent with Microsoft Office 2003 Editions.

· Take advantage of online help and training to access relevant and up-to-date support.

· Download a template from the Template Gallery to start your projects rather than starting from scratch.
Summary of New and Improved Features in Microsoft Office Project Standard 2003
The features listed in this section are either new or improved in Project Standard 2003.  More information about each feature follows in subsequent sections of this document. You can hyperlink to the content for any topic by holding down the CTRL key and clicking on a Feature name in the table below. All of these capabilities are also available in Microsoft Office Project Professional 2003.
	
	Feature
	Interface
	Description

	
	Organized Work

	
	Better organize your projects and people with the scheduling power and capabilities of Project Standard.

	New
	Proposed Booking of Resources
	Project Standard
	Proposed booking allows you to assign resources to tasks in a “proposed” or “reserved” assignment state. It marks a resource as not truly committed to the project.

	
	Display the information you want to review.

	New
	Value Lists in Filters
	Project Standard
	When creating filters in Project Standard 2003, in the “Values” field, you can select from a pick list rather than having to manually type entries.

	
	Customize plans to capture information specific to your projects.

	Improved 
	Project Guide
	Project Standard
	Improvements have been made to the Project Guide to make it easier for developers to customize it. The major change is that hard-coded paths for files are no longer required.

	
	Compelling Communications

	
	Increase your impact at work by communicating and presenting ideas and information more effectively in programs in the Microsoft Office System and through industry-standard formats.

	New
	Copy Picture to Office Wizard
	Project Standard
	The Copy Picture to Office wizard helps you easily create new presentations of Project data in Microsoft Office Word, Microsoft Office PowerPoint® and Microsoft Office Visio®.

	New
	XML Reporting Wizard
	Project Standard
	The XML Reporting Wizard helps you generate HTML documents from project data using XSL templates.

	
	Communicate more clearly by using new enhancements to effectively print one-page project schedules.

	New
	Project Guide for Printing Wizard
	Project Standard
	The Project Guide now has a “Print Current View as a Report” wizard to help users more easily print what they see.

	
	Share project information with team members through Windows SharePoint Services.

	New
	Shared Workspaces
	Project Standard (requires Windows SharePoint Services)
	Shared Workspaces allow users (who do not need the power of Microsoft Office Project Server) to store Project files and other documents centrally with others.  Shared workspaces are based on Windows SharePoint Services.

	
	Familiarity and Ease of Learning

	
	Navigate and learn the program quickly with an updated interface that is consistent with Microsoft Office 2003 Editions. Take advantage of online help and training to access relevant and up-to-date support. Download a template from the Template Gallery to start your projects rather than starting from scratch.

	New
	Office 2003 Editions Task Panes
	Project Standard
	This set of task panes incorporates various features from Microsoft Office 2003 Editions, including:

· Getting Started Pane
· Search Results Pane
· Help Pane 

· Templates on Microsoft Office Online

	Improved
	Watson
	Project Standard
	Microsoft Office Project Professional 2003 includes the Watson crash reporting technology, shared among Microsoft Office programs and operating systems such as Microsoft Windows® XP.


 Microsoft Office Project Standard 2003 in Action
Organized Work
Proposed Booking of Resources

Proposed booking is a new feature in Microsoft Office Project 2003 that can help organizations plan ahead by allowing them to track potential resource assignments for projects that are still in the proposal phase. Proposed booking implies a “reserved” assignment state, and marks a resource as not truly committed to the project. Some organizations may see proposed booking as a way of locking in the availability of a resource. They can use it to separate real assignments from proposed assignments. 
To support proposed booking, a new field called “Booking Type” has been added to Project. Since Booking Type (“Proposed” or “Committed”) is new, the booking type of a resource will be ignored when a Project 2003 .mpp file is opened in an earlier version of Project (i.e., all assignments for a “Proposed” resource will be “Committed”). While proposed booking is used to flag resource assignments, the common usage is to apply it at the project level for each resource, NOT at the task level for each assignment. 
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Figure 1: Editing Booking Type in Resource Table

In addition to setting Booking Type in the Resource Table view, booking type can be set in the Resource Information dialog, where there is a new dropdown on the General tab.
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Figure 2: Editing Booking Type in Resource Information Dialog

For assembling project teams, availability evaluation, and report creation purposes, there is a clear distinction between committed-booked and proposed-booked resources and their assignments. 
For example, when leveling, you will be able to specify whether to level resources with “Proposed” booking type or not. The “Level resources with the proposed booking type” checkbox will be unchecked by default. When unchecked, proposed resources are not taken into consideration when leveling. When checked, then tasks using proposed resources as well as confirmed resources are considered in the leveling process.
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Figure 3: Resource Leveling Considering Booking Type
With proposed bookings, resources do not become over-allocated and stay available for other assignments. This can be reflected in the Resource Graph view, where the user will be able to specify whether proposed bookings are shown in the graph.
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Figure 4: Resource Graph view with Proposed Bookings
Value Lists in Filters

When you create a filter in Microsoft Project 2002 and earlier, the Values field did not allow you to choose valid values from a pick list. For example, if you had defined the Text1 field to include a pick list with the values of A, B and C and wanted to create a filter that finds all tasks with the letter “A” in the Text 1 field, you would have had to remember and type the exact value you wanted to filter on and the filter would have looked similar to Figure 5.
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Figure 5: Filter Definitions

This is not too hard to manage if your value lists/pick lists are simple. However, more complicated value lists (including outline codes), remembering exactly what value to enter into your filter can be cumbersome. Therefore, in Project 2003, you can use a pick list to select the value for your filters as shown in Figure 6. 
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Figure 6: Pick Lists

Project Guide

Improvements have been made to the Project Guide to make it easier for developers. The major change is that hard-coded paths for files are no longer required.

Compelling Communications

Copy Picture to Office Wizard
Previous versions of Project allowed you to create a picture to copy into another application such as PowerPoint® by using the Copy Picture command. Through a bit of trial and error, you could select the right options to give you what you wanted. Now, the process is greatly streamlined with the Copy Picture to Office Wizard. 

To start the wizard, click on the Copy Picture to Office Wizard button on the Analysis Toolbar.
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If the Analysis Toolbar is not present, click on the View menu, point to Toolbars, and click on Analysis. The wizard guides you through the steps of creating a picture for a targeted application.

To start the wizard, from the View menu, click Toolbars and then select Copy Picture to Office.  Next, on the toolbar, click the Copy Picture to Office Wizard button. The wizard guides you through the steps of creating a picture for a targeted program.

The first step is to select an outline level for the project and click the Next button (see Figure 7).
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Figure 7: Copy Picture to Office Wizard - Step 1

The second step is to specify what part of the file should be copied, the timescale for the data, and what size image you want (see Figure 8).
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Figure 8: Copy Picture to Office Wizard - Step 2

The third step is to select the application that the picture is destined for (see Figure 9).
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Figure 9: Copy Picture to Office Wizard - Step 3

The wizard also provides other benefits such as adding common project-level fields to the output in Step 4 similar to those shown in Figure 10. 
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Figure 10: Copy Picture to Office Wizard - Step 4

Finally, the picture and related information are placed into a document in the target application. Figure 11 below shows how the copied picture looks inside a document created with Microsoft Office Word.
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Figure 11: Copy Picture to Office Wizard Results
XML Reporting Wizard

With Project 2003, you can easily produce reports from XSL style sheets by using the XML Reporting Wizard. The first step is to choose an XML file. The wizard will allow you to locate one, or create one from an existing project. Click on the New File radio button to create an XML file from the active project or click on the Existing radio button to browse for a file (see Figure 12 below).
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Figure 12: Choose an XML File
The second step is to pick an XSL/T file (Figure 13). The XSL/T file specifies how to transform the XML to create the report. There are a couple of included XSL/T files included which transform the XML to HTML.  The CRTTASK.XSL file will transform your XML file into an HTML report showing tasks on the critical path. The RESOURCE.XSL file will transform your XML file to an HTML report listing over-allocated resources (see Figure 14). Click on the Browse button and pick one of the included files (see Figure 14) or navigate to one of your own.
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Figure 13: Select an XSL/T File
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Figure 14: Included XSL/T Files

You can then preview the report or save it. Figure 15 shows an example report using the CRITTASK.XSL file to display tasks on the critical path.
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Figure 15: Example Preview Report
Project Guide for Printing Wizard

New with Microsoft Office Project 2003, you can more easily discover the printing options available in Project by printing directly from the Project Guide. Simply follow the Project Guide instructions for optimal printing of views in Project. Note that printing Project reports is not supported.

The Project Guide for printing is accessed from the Project Guide via the Report goal area.
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Figure 16: Project Guide for Printing Wizard

By clicking the Print current view as a report Project Guide link, you can use a wizard to print one or multiple pages and select sizing options for fonts you want, the desired timescale date range, and which columns and tasks should be printed. Next, you can set the header and footer details, print margins, and specify how notes are printed, page breaks and more. During all wizard steps, you can choose to print preview or to print.


Shared Workspaces
If you have a server running Windows SharePoint Services, you can save your projects to the server and take advantage of the many new features Windows SharePoint Services offers. The Shared Workspace feature (shared with other Microsoft Office 2003 programs) allows you to see other users’ SharePoint tasks (not to be confused with Project tasks), documents, lists, and team member names, all from a task pane that is integrated into Project 2003. You can also check documents (.MPP files) in and out from the workspace. To activate the workspace features, you need to:

1. Have access to a server that is running Windows SharePoint Services. You should also create a workspace and then enable permissions to the workspace.

2. Save a project (.MPP file) to the server that is running Windows SharePoint Services. For example, create a new project, then in the Save As dialog (on the File menu) enter the URL to your server running Windows SharePoint Services in the File Name field, as shown in Figure 17.
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Figure 17: Saving From Project to a Shared Workspace

When you click Save, Project Standard connects you to the Windows SharePoint Services-extended server where you can see other documents that have already been saved or workspaces that you have created; at this point, you can select a workspace, then enter a project name and then click Save to finish the saving process.
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Figure 18: Saving to a Project Workspace

Once you have saved a project to the shared workspace on the server running Windows SharePoint Services, a number of menu items become available to you. On the Tools menu, the Shared Workspace option becomes active. Selecting this activates the Shared Workspace pane. Additionally, on the File menu, the Check-out/Check-in and Versions menus become available (see Figure 19).
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Figure 19: Menu Items Enabled When Using Shared Workspaces

In the Shared Workspace pane, you can click on the Members icon to see a list of other members of your group and whether they are online, to add new members to the workspace, and to send e-mails to the group (Figure 20).

You can click on the documents icon in the Shared Workspace pane to see a list of documents that are stored in the workspace, to add documents to the workspace, and to set up event notifications for documents (Figure 21).
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Figure 20: Shared Workspace Members

[image: image22.png]%] Microsoft Project - Task Assignments.m
[Eie ] edt vew Insert Fomat Took

HRNEA RN AR N,

@ 9+ = o show~ | el

2] Tess_ | Resources | Track_ - [Repor

Shared Workspace - x
(¢ 1©n]

Projectsite
Open ste in brovser

Documents Sortby v

[ ——

4] Task Assnments o1
(Currently Open Document)

) Projec Evampl. doc
) Deiverabis.coc
Proect.doc

13 addnen documert
Adnew Fokder

L& Alert me about documents,

GetUpdates | Options.

Last updated: 11/14/2003 3:39 PM




Figure 21: Shared Workspace Documents

You can check out project files (.MPP files) from the common workspace and also create versions. For example, if you check out a Project file and then close it, you will see the message shown in Figure 22.

 [image: image23.png]Check In

Task Assignments.mpp s checked oLt by you.

D0 you want to
& [Save changes and checkin)
 Save changes oy
" Discard changes and undo check out
 Discard changes anly

ok

Cancel





Figure 22: Check In

Should you choose to check in the Project file, you are prompted for comments that are saved with the version you are saving, as shown in Figure 23.
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Figure 23: Check In Comments

If you select the Versions menu item, you see the dialog box shown in Figure 24.
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Figure 24: Versions Dialog Box

 In the Versions dialog box, you can choose to open a given version, delete a version, view the comments, or restore a versioned Project file as the current Project file.

Use Service Options to change the behaviors of the Shared Workspace. To get to Service Options, click Options on the Tools menu, then click on the General tab, and then click the Service Options button.
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Figure 25: Service Options
Familiarity and Ease of Learning
Office 2003 Editions Task Panes

Microsoft Office Project 2003 implements a number of the Office 2003 task panes that are keenly focused around user assistance.

Additionally, when users are connected to the Internet while using Microsoft Office Project 2003, they automatically receive Help content improvements made over time, without having to subscribe to any Microsoft Office 2003 services to enjoy this benefit.

Getting Started Pane

Microsoft Office Project 2003 users can get additional information when they are connected to the Internet from within Microsoft Office Project 2003 in the Getting Started pane. The Getting Started pane helps users link to Microsoft Office Online Web page, and improved search accuracy provides up-to-date Help topics. A list of most recently used files is also provided in the Getting Started pane. 
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Figure 26: Getting Started Pane
Search Results Pane

Search results are highlighted in a task pane in Project 2003. Users can specify if they want to search Microsoft Office Online, offline help files, clip art and media, or the Office Marketplace. The type of content that is returned is clearly marked so that you can distinguish between items such as Help and templates, and whether the information is available from the Web or from within Project. Users can also still get Help even if they are not connected to the Internet. Offline or online, the query and results user interface are the same, allowing users to transparently take advantage of the network.
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Figure 27: Search Results Pane

Help Pane

The Help Pane displays the expanded set of Help alternatives. When you click Project Help on the Help menu, the Help Pane appears, allowing you to either use Search or browse the Web to find the information you need. The Help Pane also provides a separate link to training, discussion groups, and downloads.
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Figure 28: Help Pane
Templates on Microsoft Office Online
Rather than start from scratch, you can download a template to start your projects. In the New Projects pane, you can opt to open a template from Microsoft Office Online. When you select a Microsoft Office Project 2003 template from the template gallery on the Web, it downloads and runs seamlessly just like any other template in a Microsoft Office System program.
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Figure 29: Templates on Office Online

Watson

Watson is a crash reporting technology shared among Microsoft Office applications and operating systems such as Microsoft Windows® XP. Watson crash reporting can more accurately track and reproduce internal asserts, internal crashes, and customer crashes. 

Some alerts that may have been confusing to users in Microsoft Project 2002 are integrated with appropriate Help content in Microsoft Office Project 2003. 
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Figure 30: Service Options Dialog

All of these new Office 2003 features that connect to the Web or send data to the Web can be controlled by you with the service options. In Microsoft Office Project 2003, from the Tools menu click Options, then select the General tab and then click on the Service Options button to see the Service Options dialog.  

Backward Compatibility and Interoperability

Microsoft Office Project 2003 maintains a backward compatibility with previous versions of Project, as described here. Project 2000, Project 2002, and Project 2003 share a common file format. You can freely open a project file (.MPP file) created in any of those three versions of Project in any other version. Features that are present in newer versions will not display when opened in older versions. You can save project plans in Microsoft Project 98 .MPP file format from Project 2000, Project 2002, or Project 2003. Any features that do not map to Project 98 will be discarded when the project is saved to Microsoft Project 98 format.

Project 2003 saves to the same set of file formats as Project 2002 including XML, XLS, MPD (Microsoft Project Database), and CSV (Comma separated Values). Project 2000 and later versions no longer save project plans to the MPX format. 

System Requirements Changes

For a list of system requirements for Microsoft Office Project Standard 2003, you can refer to 

http://www.microsoft.com/office/project. 
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